


 

СОДЕРЖАНИЕ УМК 
РАБОЧАЯ ПРОГРАММА .......................................................................................... Ошибка! Закладка не определена. 

1.Цели и задачи изучения дисциплины, ее значение в учебном процессе ............................................................... 2 

2.Компетенции по Госстандарту ..................................................................................................................................... 3 

3.Межпредметные связи. Перечень дисциплин и их разделов, усвоение которых необходимо при изучении 
данной дисциплины. ....................................................................................................................................................... 5 

4.Структура дисциплины с разбивкой по видам занятий, часам и модулям ............................................................. 5 

5.Темы для самостоятельной работы студентов. ......................................................................................................... 8 

6.Распределение баллов по модулям и видам учебных занятий ............................................................................. 10 

7.Список литературы ..................................................................................................................................................... 10 

7.1.Интернет-ресурсы ................................................................................................................................................ 11 

8.Вопросы (тесты) к модулям ....................................................................................................................................... 12 

9.Учебно-методические материалы ............................................................................................................................. 14 

10.Методическая разработка аудиторных форм работы (Содержание практических занятий) ............................ 14 

11.Формы текущего и итогового контроля .................................................................................................................. 40 

12.Учебно-методическая литература по дисциплине разработанная преподавателями отделения .................... 57 

13.Глоссарий. ................................................................................................................................................................. 58 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 





С.А.Ниязмаметова   КГиМ 2 

 

1.Цели и задачи изучения дисциплины, ее значение в учебном процессе 
1.1. Цели дисциплины 

Целями освоения дисциплины «Инженерная графика и компьютерная графика» являются: 

● развитие пространственного представления и воображения; 

● развитие способностей к анализу и синтезу пространственных форм и их отношений на 

основе чертежей конкретных объектов; 

● освоение средств обработки и редактирования компьютерной графики; 

● создавать, редактировать и оформлять чертежи на персональном компьютере; 

иметь представление:  

● о средствах и методах обработки и редактирования компьютерной графики;  

● о проблемах и направлениях развития графического дизайна;  

● об основных методах и средствах создания и редактирования графических файлов;  

● об использовании графических программных пакетов.   

 

1.2. Задачи изучения дисциплины 

Обучающие: 

1. Изучение основных направлений развития информатики в области компьютерной 

графики; 

2. Изучение методологии и технологии выполнения графических работ на компьютере; 

3. Формирование представлений об образовании изображений (проекций); навыков 

определения геометрических форм деталей по их изображениям; 

4. Изучение программных средств компьютерной графики, алгоритмов создания графических 

примитивов, принципов создания трехмерной и фрактальной графики; 

5. Ознакомление студентов с базовыми принципами создания компьютерной графики, 

основными моделями представления цвета, базовой архитектурой компьютерных 

графических подсистем, математическими принципами и базовыми алгоритмами создания 

компьютерной графики, аппаратной частью графических подсистем; 

6. Научить студентов применять современные информационные технологии для решения 

типовых задач в профессиональной деятельности. 

7. Обучение художественным навыкам оформления документов на компьютере (титульных 

листов, объявлений, открыток и пригласительных, текстового оформления, рекламных 

проспектов) 

8. Развитие интереса к компьютерной графике, дизайну 

Развивающие: 

1. Подготовить сознание студентов к системно-информационному восприятию мира, развивать 

стремление к самообразованию, обеспечить в дальнейшем социальную адаптацию в 

информационном обществе и успешную профессиональную и личную самореализацию; 

2. Владеть современными образовательными и информационными технологиями, навыками 

работы с программными средствами общего назначения, соответствующими современным 

требованиям мирового рынка, основам и автоматизации решения задач в профессиональной 

деятельности. 

Воспитательные: 

1. Формировать информационную и эстетическую культуру обучающихся; 

2. Развивать творческие способности, способность креативно мыслить 
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3. Осознанно выполнять профессиональные требования, ответственность, пунктуальность, 

дисциплинированность, трудолюбие;  

4. Развивать критическое мышление, нацеленное на достижение поставленных целей; 

5. Воспитание профессиональной культуры и профессиональных качеств дизайнера, 

рациональности, бережливости, стремления к качественному выполнению работы. 

 

В результате освоения дисциплины студент должен:  

Знать 

• методы и средства компьютерной графики и геометрического моделирования; 

•  основы векторной и растровой графики; 

• теоретические аспекты фрактальной графики; 

• основные методы компьютерной геометрии; 

• принципы формирования цифрового изображения; 

• правила обработки и подготовки изображений для публикации в электронных и бумажных 

изданиях; 

• основы композиции, правила построения графических изображений и верстки изданий. 

Уметь 

• Применять компьютеры и телекоммуникационные средства; 

• выполнять основные манипуляции (редактирование, удаление, перемещение, копирование 

фрагментов изображения); 

• управлять атрибутами изображения; 

• создавать, редактировать и оформлять чертежи на персональном компьютере; 

• эффективно использовать текстовые и графические редакторы при решении задач в сфере 

профессиональной деятельности; 

• применять средства компьютерной графики в процессе дизайнерского проектирования. 

• использовать современное программное обеспечение в области разработки компьютерной 

графики. 

 

Владеть:  

• Навыками поиска, обработки и применения информации. 

• Обработки фотоизображений 

• Выполнять графические изображения с применением масштабирования 

• Создания композиций и верстки 

• Техникой и принципами нанесения размеров; 

• Основными приемами создание и редактирования изображений в векторных редакторах  

• навыками редактирования фотореалистичных изображений в растровых редакторах 

• Работой с графическими библиотеками. 

 

 

 

2.Компетенции по Госстандарту. 

 

 Выпускник в соответствии с целями основной профессиональной образовательной 

программы и задачами профессиональной деятельности, указанными в пунктах 11 и 15 
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настоящего Государственного образовательного стандарта, должен обладать следующими 

компетенциями:  

а) общими (ОК):  

ОК-1. Уметь организовывать собственную деятельность, выбирать методы и способы 

выполнения профессиональных задач, оценивать их эффективность и качество.  

ОК-2. Решать проблемы, принимать решения в стандартных и нестандартных ситуациях, 

проявлять инициативу и ответственность.  

ОК-3. Осуществлять поиск, интерпретацию и использование информации, необходимой для 

эффективного выполнения профессиональных задач, профессионального и личностного 

развития.  

ОК-4. Использовать информационно – коммуникационные технологии в профессиональной 

деятельности.  

ОК-5. Уметь работать в команде, эффективно общаться с коллегами, руководством, клиентами.  

ОК-6. Брать ответственность за работу членов команды (подчиненных), за результат выполнения 

заданий.  

ОК-7. Управлять собственным личностным и профессиональным развитием, адаптироваться к 

изменениям условий труда и технологий в профессиональной деятельности.  

ОК-8. Быть готовым к организационно – управленческой работе с малыми коллективами.  

ОК-9. Способен приобретать новые знания, с большой степенью самостоятельности, с 

использованием современных образовательных и информационных технологий.  

ОК-10. Способен на научной основе оценить свой труд, оценивать с большой степенью 

самостоятельности, результаты своей деятельности. 

 

 

 

 

230109 – «Программное обеспечение вычислительной техники и автоматизированных 

систем» 

б) профессиональными, соответствующими основным видам профессиональной деятельности 

(ПК):  

производственно-технологическая деятельность:  

ПК-1. Владеет знаниями об архитектуре и технических характеристиках персональных 

компьютеров; 

ПК-8. Способен осуществлять модификацию, адаптацию и настройку программных продуктов; 

ПК-11. Владеет знаниями о правилах и нормах охраны труда, техники безопасности, 

промышленной санитарии и противопожарной защиты. 

ПК-13. Способен реализовать функции сопровождения программных продуктов; 

ПК-16. Способен обеспечивать эффективное применение пакетов прикладных программ; 

 
230701 – «Прикладная информатика (по отраслям)» 

ПК-6 - осуществлять сбор и анализ информации для определения потребностей клиента. 

ПК-12 - осуществлять продвижение и презентацию программного обеспечения отраслевой 

направленности. 
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3.Межпредметные связи. Перечень дисциплин и их разделов, усвоение 
которых необходимо при изучении данной дисциплины. 
 

Пререквизиты: Основы информационной и вычислительной техники, введение в 

специальность. 

 

Постреквизиты: Компьютерные технологии в проектировании среды, трехмерное 

моделирование, а также для прохождения производственной и квалификационной практики. 

4.Структура дисциплины с разбивкой по видам занятий, часам и 
модулям 

Структура дисциплины за I полугодие 

№ 
Тематика лекционных занятий Кол-во 

часов 

Наименование тем 

практических занятий 

Кол-во 

часов 

Прим. 

1 

Инженерная графика 

Единая система конструкторской 

документации (ЕСКД) 

Общие правила оформления 

чертежей 

Изображения -виды, разрезы, 

сечения. 

Условные графические изображения 

на чертежах 

Правила нанесения размеров. 

Построение изображений. 

Порядок выполнения эскиза. 

6 

Основы работы с 

объектами. 

Вращение, комбинирование 

объектов CorelDraw. 

 

4  

 

Основы компьютерной графики 

История компьютерной графики 

Виды компьютерной графики 

Методы представления графических 

изображений 

4 

Создание и редактирование 

контуров в Corel Draw. 

Создание рисунков 

из кривых. 

Создать объекты по образцу. 

 

4  

Модуль 1 

 

Аппаратное обеспечение 

компьютерной графики. 

Видеокарта (видеоадаптер) 

Монитор. Растровый принцип 

вывода изображений. Размер 

графической сетки (растра).  Виды 

мониторов 

Принтеры 

Устройства ввода изображения в 

компьютер 

4 

Упорядочивание, 

группирование, соединение, 

объединение, объектов. 

Эффект объема. 

Перетекание. 

2  
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Форматы графических файлов. 

Преобразование файлов из одного 

формата в другой. 

Векторные форматы 

Растровые форматы 

Сохранение изображений в 

стандартных и собственных 

форматах графических редакторов 

Преобразование форматов 

графических файлов 

4 

 

Исключение, пересечение 

объектов.  

Выравнивание объектов. 

 

2  

 

Понятие цвета. Цветовые модели. 

Понятие цвета. Способы описания 

цвета 

Цветовая модель RGB 

Цветовая модель CMYK 

Цветоделение при печати 

 

 

 

 

4 

 

Отражение, копирование и 

удаление объектов.  

Создание и редактирование 

контуров в Corel Draw.  

 

2  

Модуль 2 

 Всего за I-полугодие 22  14  

 

Структура дисциплины очного отделения за II полугодие 

№ 

Тематика лекционных занятий Кол-во 

часов 

Наименование тем 

практических занятий 

Кол-

во 

часов 

Прим. 

 

Фрактальная графика 

Понятие фрактала и история появления 

фрактальной графики. 

Понятие размерности и ее расчет. 

Геометрические фракталы 

Алгебраические фракталы 

4 

Освоение приемов 

работы с 

многослойными 

изображениями в 

программе Adobe 

Photoshop (создание 

коллажа) 

2  

 

Векторная графика 

Векторная графика, общие сведения 

Элементы (объекты) векторной 

графики.  

Объекты и их атрибуты. 

Цвет в векторной графике. 

Структура векторной иллюстрации. 

Достоинства векторной графики. 

Недостатки векторной графики. 

Средства для создания векторных 

изображений 

4 

Освоение приемов 

художественной 

обработки фотографий в 

программе Adobe 

Photoshop. 

 

2  

 

Растровая графика 

Растровая графика, общие сведения. 

Растровые представления изображений. 

Виды растров. 

4 

Эффекты имитации 

Adobe Photoshop, 

фильтры, параметры 

слоя, трансформация 

изображения 

2  
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Достоинства и недостатки растровой 

графики 

О сжатии растровой графики. 

Геометрические характеристики 

растра. 

Количество цветов растрового 

изображения. 

Форматы растровых графических 

файлов. 

Модуль-1 

 

Трехмерная графика 

История трехмерной графики. 

Сферы применения трёхмерной 

графики, примеры 3D‑объектов. 

Особенности работы с 3D‑графикой. 

Этапы создания трехмерного проекта. 

6 

Основы работы с 

графическим 

редактором AutoCAD 

Освоение интерфейса 

системы AutoCAD, 

настроек графического 

редактора, команд 

вычерчивания 

графических 

примитивов и 

выполнения надписей на 

чертежах. 

4  

4 

Инфографика как средство 

визуализации информации 

Категории инфографики. 

 Принципы инфографики.  

Технология создания инфографики. 

Советы по созданию качественной 

инфографики.  

Составляющие успеха инфографики.  

Сервисы для создания инфографики. 

 

 

 

4 

Создание инфографики 

с помощью Canva.com - 

on-line сервис для 

создания инфографики 

Powtoon.com - on-line 

сервис для создания 

инфографики 

4  

 Модуль-2 

 Всего за II полугодие 22  14  

 Итого за год 44  28  
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Структура дисциплины заочного отделения 

№ 
Тематика лекционных 

занятий 

Кол-во 

часов 

Наименование тем практических 

занятий 

Кол-во 

часов 

Прим. 

1 

Инженерная графика 

Единая система 

конструкторской 

документации (ЕСКД) 

Общие правила 

оформления чертежей 

Изображения -виды, 

разрезы, сечения. 

Условные графические 

изображения на чертежах 

Правила нанесения 

размеров. 

Построение изображений. 

Порядок выполнения 

эскиза. 

2 

Основы работы с 

объектами. 

Вращение, комбинирование объектов 

CorelDraw. 

Создание и редактирование контуров в 

Corel Draw. 

Создание рисунков 

из кривых. 

Создать объекты по образцу. 

 

2  

 

Основы компьютерной 

графики 

История компьютерной 

графики 

Виды компьютерной 

графики 

Методы представления 

графических 

изображений 

2 

Упорядочивание, группирование, 

соединение, объединение, объектов. 

Эффект объема. 

Перетекание. 

Исключение, пересечение объектов.  

Выравнивание объектов. 

2  

 

Понятие цвета. 

Цветовые модели. 

Понятие цвета. Способы 

описания цвета 

Цветовая модель RGB 

Цветовая модель CMYK 

Цветоделение при печати 

2 

Освоение приемов работы с 

многослойными изображениями в 

программе Adobe Photoshop (создание 

коллажа) 

2  

 

 Всего  6  6  
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5.Темы для самостоятельной работы студентов. 
№ Наименование тем СРС Кол-во 

часов 

Примечание 

1.  Применение эффекта перетекание в Corel Draw на 

примере объемных изображений чаши, бокала 

4  

2.  Создать рисунок с осколком стекла с применением 

эффекта Линза-увеличение. 

4  

3.  Создание рисунков и кривых в Corel Draw с на 

примере создания рисунка «Яблоко». 

4  

4.  Текстовые эффекты. Лазерная надпись (имитация 

неонового света в программе Adobe Photoshop 

4 

4 

 

5.  Текстовые эффекты. Буквы под водой в программе 

Adobe Photoshop 

4  

 Всего за 1 полугодие 24  

6.  Текстовые эффекты. Хромированный текст в 

программе Adobe Photoshop 

4  

7.  Текстуры. «Камуфляж» в программе Adobe 

Photoshop 

4  

8.  Эффекты имитации. «Имитация дождя» в программе 

Adobe Photoshop 

4  

9.  Имитация изображения, погружённого в воду в 

программе Adobe Photoshop 

4  

10.  Построение изометрических изображений AutoCAD 4  

11.  Создание инфографики в Canva.com 4  

 Всего за 2 полугодие 24  

 ИТОГО за год 48  
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6.Распределение баллов по модулям и видам учебных занятий 
 

№ Этапы проверки Вид средства проверки Баллы 

1 1 модуль 

Проверка практических заданий. 

Устный, тестирование.  

Посещение занятий. 

100 

2 2 модуль 

Проверка практических заданий. 

Тестирование. 

Посещение занятий. 

100 

3 

 

Итоговый контроль: 

• Практическое занятие; 

• СРС. 

Контрольные и графические работы, 

презентации, СРС, практические 

задания. 

Тестирование.  

Посещение занятий. 

100 

 Итого средний балл   100 

 

 

Итоговое распределение баллов по модулям 

 

 Удовлетворительно Хорошо Отлично 

Модуль 1 – 100 б. 60-79 80-89 90-100 

Модуль 2 – 100 б. 60-79 80-89 90-100 

Практическое занятие – 

50 б. 

Итоговый  

контроль 

 

60-79 

 

80-89 

 

90-100 

СРС – 50 б. 

 

7.Список литературы 
 

№ Библиографическое описание издания (автор, наименование, вид, место 

и год издания, кол. стр.) 

1 Аверин, В.Н. Компьютерная графика: Учебник / В.Н. Аверин. - М.: Academia, 2016. 

2 Аверин, В.Н. Компьютерная инженерная графика: Учебное пособие / В.Н. Аверин. - М.: 

Academia, 2019. 

3 Абрамов А. Е. Компьютерная графика. Учебно-методический комплекс. 2009. 

4 Божко А. Н. и др. Компьютерная графика. МГТУ, 2009. 

5 Инженерная графика. [Электронный ресурс]: учебник / Н. П. Сорокин [и др.]. – Санкт-

Петербург : Лань, 2016. – 392 с. 

6 Инженерная и компьютерная графика: Учебник / В.М. Дегтярев. - М.: Academia, 2011. 

7 Компьютерная графика и дизайн: Учебник / В.Т. Тозик. - М.: Академия, 2009. 

8 • Дегтярев В. М. Инженерная и компьютерная графика [Текст]: учебник для вузов / В. М. 

Дегтярев, В. П. Затыльникова. - Москва: Академия, 2010. - 240 с. 

9 Сейтказиева Н.С., Компьютерная графика, Учебно-дидактическое пособие с 

практическими заданиями по компьютерной графике для студентов Колледжа 

http://mirknig.com/knigi/design_grafika/1181535762-kompyuternaya-grafika.html
http://mirknig.com/knigi/design_grafika/1181615967-kompyuternaya-grafika.html
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специальности «Программное обеспечение вычислительной техники и автоматизации 

систем», Бишкек-2017, 121 стр. 

10 Анцыпа В. А. Растровые и векторные графические изображения // Информатика и 

образование. - 2005. - № 7. - С. 56-62. 

11 Куприянов Н. И. Рисуем на компьютере: Word, Photoshop, Corel Draw, Flash. - СПб.: 

Питер, 2005. - 128 с. 

12 Федоров А. В. Corel Draw. Экспресс-курс. - СПб.: БХВ-Петербург, 2005. - 400 с. 

13 Андрианов В. И. Самое главное о… Corel Draw. - СПб.: Питера, 2004. - 127 с. 

14 Adobe Photoshop CS официальный учебный курс: Пер. с англ. - М.: Изд-во ТРИУМФ, 

2009. - 576 с. ил. 

15 Бурлаков М.В. Эффекты в программах растровой графики. Справочное пособие. - М.: 

Изд-во ТРИУМФ, 2010. - 70 с. 

 

 

7.1.Интернет-ресурсы 

1. онлайн-редактор визуального контента: изображений, видео, анимации и документов 

Canva.com. 

2. Сервис для создания анимации Powtoon.com. 

3. Ниязмаметова С.А., онлайн курс 

https://classroom.google.com/c/NjEyNzk1ODg4NTFa?cjc=ial3xyj  

4. https://learningapps.org/ Сайт для создания мультимедийных интерактивных упражнений. 

 

 

 

 

 

 

  

https://learningapps.org/
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8.Вопросы (тесты) к модулям 
 

№ 1 полугодие Перечень вопросов (тестов)  

1  

 

 

 

Модуль 1 

 

 

 

 

 
 

2 Модуль 2 

 

 

 

 Результат (скрин) онлайн теста разместите в classroom: 

1) Открыть ссылку - https://classroom.google.com 

1) Код курса «Инженерная и компьютерная графика» - ial3xyj 

(https://classroom.google.com/c/NjEyNzk1ODg4NTFa?cjc=ial3xyj ) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

https://classroom.google.com/
https://classroom.google.com/c/NjEyNzk1ODg4NTFa?cjc=ial3xyj%20


С.А.Ниязмаметова   КГиМ 13 

 

№ 2 полугодие Перечень вопросов (тестов) для 

практических работ 

 

 

 

Модуль 1 

 

1  

 
 Модуль 2 

 

2 

 
 Результат (скрин) онлайн теста разместите в classroom: 

2) Открыть ссылку - https://classroom.google.com 

2) Код курса «Инженерная и компьютерная графика» - ial3xyj 

(https://classroom.google.com/c/NjEyNzk1ODg4NTFa?cjc=ial3xyj ) 

 

 
 
 

https://classroom.google.com/
https://classroom.google.com/c/NjEyNzk1ODg4NTFa?cjc=ial3xyj%20
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9.Учебно-методические материалы 

1. Ниязмаметова С.А., онлайн курс https://classroom.google.com/c/NjEyNzk1ODg4NTFa?cjc=ial3xyj 

2. https://learningapps.org/user/Сахинур2, онлайн сервис с созданными мною заданиями. 

10.Методическая разработка аудиторных форм работы  

Содержание лекционных занятий 
 

 

  

https://classroom.google.com/c/NjEyNzk1ODg4NTFa?cjc=ial3xyj%20
https://learningapps.org/user/Сахинур2
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Содержание практических занятий 
 

Практическая работа. 

ПРАКТИЧЕСКАЯ РАБОТА №1 

ОРНАМЕНТ 

Цель работы: научиться создавать изображение абстрактного орнамента с помощью 

Corel Draw 

1. С помощью инструмента Эллипс  создайте форму лепестка, которая 

понадобится для создания цветка (Рис.1.1). 

2. Выберите инструмент Форма  и нажмите Ctrl+Q. 

3. С помощью инструмента Форма преобразуйте эллипс к следующему виду (Рис.1.2). 

4. Выберите инструмент Указатель и произведите одинарный или двойной щелчок по 

объекту, что придать границам его размеров следующий вид (Рис.1.3). 

5. Перетащите центр Формы (в виде круга) в основание (Рис.1.4). 

 

 

6. Выполните следующую команду: Упорядочить → 

Преобразование → Поворот или нажмите сочетание 

клавиш Alt+F8. 

7. В открывшемся справа диалоговом окне 

введите значение угла 12 или другое число, кратное 360 

(Рис.1.5). 

8. Нажмите Применить к дубликату. Результат 

выполненного действия представлен на Рис.1.6. 

Рис.1.4 Перенос центра Формы 

Рис.1.1 Создание 
эллипса 

Рис.1.2 
Преобразование 

эллипса 
Рис.1.3 Изменение параметров 

границ 

Рис.1.5 Задание значения угла 

Рис.1.6 Результат применения к дубликату 
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9. Нажимайте на кнопку Применить к 

дубликату до тех пор, пока не получите 

изображение, похожее на то, как на Рис.1.7. 

10. Выберите все лепестки и заполните 

желаемым цветом (Рис.1.8). 

Рекомендации: если лепестков слишком много, не всегда 

получится с помощью выделения мышью по одному лепестку 

закрасить все лепестки. В этом случае можно выбрать один 

лепесток, заполнить его желаемым цветом, и переключиться 

на другой лепесток с помощь клавиши Tab на клавиатуре. 

11. Выделите все лепестки (этот шаг можно пропустить, 

если лепестки вы закрашивали не по отдельности) (Рис.1.9). 

Если в результате выделения у Вас не образовался по центру 

цветка круг из точек, значит, выделены не все лепестки. 

12. Выполните команду Упорядочить → Объединить 

или нажмите сочетание клавиш Ctrl+L. 

13. Результат представлен на Рис.1.10. Сказочный цветок 

готов ☺ 

Рис.1.7 Многократное применение к дубликату 

Рис.1.8 Закраска лепестков 

Рис.1.9 Результат выделения 
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ПРАКТИЧЕСКАЯ РАБОТА №2 

БУСЫ 

Цель работы: научиться создавать изображение бус с помощью Corel Draw 

1. С помощью инструмента Эллипс нарисуйте нить, на которую будете 

нанизывать бусинки (Рис.3.1).  

2. Удерживая Shift, нарисуйте круг. 

3. Залейте его радиальным градиентом любого цвета, 

установив в диалоговом окне градиентной заливки сдвиг 

центра по горизонтали = -17%, по вертикали = 19% 

(Рис.3.2). Результат – на Рис.3.3. 

4. Сделайте контур непрозрачным (щелкните правой 

кнопкой мыши в палитре цветов на значке ). 

5. Сделайте копию бусины (нажмите "+" на правой 

панели клавиатуры) и установите ее на некотором расстоянии 

от первой окружности. Чтобы сдвиг был строго по 

горизонтали, при перемещении удерживайте нажатой 

клавишу Ctrl. 

Рис.1.10 Примеры созданных орнаментов ☺ 

Рис.3.1 
Нитка для 

бус 

Рис.3.2 Диалоговое окно настройки 
радиальной заливки 



С.А.Ниязмаметова   КГиМ 18 

 

 

 

 

6. На панели инструментов выберите инструмент Интерактивное перетекание   

7. Установите появившийся курсор  на 

первой бусине и растяните пунктирную линию до 

второй бусины. На панели параметров в окне Число 

шагов  установите необходимое 

вам число. Результат – на Рис.3.5. 

8. Для распределения бусинок на нитке выберите кнопку 

«Свойства пути»  на панели параметров команды 

Интерактивное перетекание. Появившийся курсор подведите к нити и 

нажмите левую кнопку мыши.  

9. Равномерно распределите бусины на нити. Для равномерного 

распределения выделите крайнюю бусину и переместите ее. (Рис.3.6). 

10. Инструментом Прямоугольник нарисуйте прямоугольник для замка.  

11. Сделайте округлые углы и залейте квадратной градиентной заливкой (Рис.3.7). 

12. Установите замочек на нити и ваши бусы готовы (Рис.3.8). 

ПРАКТИЧЕСКАЯ РАБОТА №3 

АПЕЛЬСИН 

Цель работы: научиться создавать изображение апельсина 

1. С помощью фигур Прямоугольник  и Эллипс нарисуйте две простые фигуры так, как 

на Рис.4.1. 

2. Преобразуйте прямоугольник в кривую (щелкните правой клавишей на фигуре и 

выберите команду «Преобразовать в кривую»). 

3. С помощью инструмента Форма измените прямоугольник до следующего вида, как на 

Рис.4.2. 

4. Выделите сначала окружность, нажмите Shift, затем выделите скругленный 

Рис.3.3 
Результат 
заливки 

Рис.3.4 Размещение копии бусины 

Рис.3.5 Результат интерактивного перетекания 

Рис.3.8 Бусы ☺ 

Рис.3.6 
Распределен
ие бусинок 

Рис.3.7 Замочек 
для бус 
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прямоугольник и нажмите на панели инструментов Исключить . Результат – на Рис.4.3. 

5. Залейте фигуры (Рис.4.4). 

6. Нарисуйте еще одну окружность и 16-конечную звезду (Рис.4.5). 

7. Выделите звезду и выберите инструмент Интерактивное искажение 

, для которого установите следующие настройки: . 

8. Залейте новую окружность и звезду Радиальной заливкой (Рис.4.6). 

9. Выберите инструмент Художественное оформление и небольшими мазками нарисуйте 

прожилки (Рис.4.7). 

10. Выделите все прожилки, сгруппируйте 

(Упорядочить → Сгруппировать), и залейте каким-либо 

цветом (Рис.4.8). 

11. Скопируйте 

нижнюю часть 

апельсина и залейте 

ее Текстурной 

заливкой (Рис.4.9). 

Рис.4.1 
Исходные 

фигуры 

Рис.4.2 
Преобразова

нный 
прямоугольн

ик 

Рис.4.3 
Результат 

исключения 

Рис.4.4 Заливка 
фигур 

Рис.4.5 
Добавление 
середины в 
виде звезды 

Рис.4.6 Заливка 
звезды и окружности 

Рис.4.7 Прожилки Рис.4.8 Закраска 
прожилок 

Рис.4.9 Настройки текстурной заливки 
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12. Наложите на апельсин и примените Интерактивную 

прозрачность (Рис.4.10). 

13. Добавьте тень (Рис.4.11). Апельсин готов. 

 

 

 

 

 

 

 

 

 

 

 

 

ПРАКТИЧЕСКАЯ РАБОТА №4 

КАПЛЯ 

Цель работы: научиться создавать изображение капли 

1. С помощью инструмента Эллипс постройте окружность, удерживая нажатой клавишу 

Ctrl. 

2. Щелкните на созданной окружности правой клавишей мыши и выберите пункт 

«Преобразовать в кривую». 

3. С помощью инструмента Форма выделите верхнюю точку Вашей 

окружности. 

4. Выберите на панели инструментов пункт «Создать узел с острым углом» 

. 

Рис.4.10 Наложение 
интерактивной 
прозрачности 

Рис.4.11 Апельсин ☺ 

Рис.7.1 
Изменение 

формы 
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5. Передвиньте верхнюю точку строго вверх и с помощью направляющих придайте 

окружности форму капли (Рис.7.1).  

6. Продублируйте каплю (Ctrl+C, затем Ctrl+V) и уменьшите ее в размерах 

(Рис.7.2). 

7. Залейте большую каплю цветом C10 M0 Y0 K0, а маленькую C100 M0 Y0 

K0. Контур у обеих капель сделайте бесцветным, щелкнув правой клавишей мыши 

на значке  в палитре цветов (рис.7.3). 

8. Примените инструмент Интерактивное перетекание от центра капли к ее 

краю. Результат – на Рис.7.4. 

9. С помощью инструмента Свободная форма (или Кривая через три точки и 

Соединительная линия) и направляющих линий нарисуйте объект, примерно, как на 

Рис.7.5. 

10. Создайте копию объекта (Ctrl+C, Ctrl+V), уменьшите и измените ее форму 

(Рис.7.6). 

11. Большую фигуру залейте цветом C40 M0 Y0 K0, а маленькую – белым. 

Контур у обеих фигур уберите (Рис.7.7). 

12. Примените инструмент Интерактивное перетекание (Рис.7.8). 

 

13. Щелкните на получившейся фигуре правой клавишей мыши и выберите команду 

«Разъединить группа с перетеканием».  

14. Не снимая выделения, примените к полученному объекту инструмент И нтерактивная 

Рис.7.2 
Дублирование 

капли 

Рис.7.3 
Раскраска 

капель 

Рис.7.4 Результат 
интерактивного 

перетекания 

Рис.7.5 
Создание 
объекта 

Рис.7.6 Копия и 
изменение 

формы 

Рис.7.7 
Заливка 

объектов 

Рис.7.8 
Результат 

перетекания 
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Рис.7.9 Параметры инструмента Интерактивная прозрачность 

прозрачность, примерные параметры которой показаны на Рис.7.9. 

Результат – на Рис.7.10.  

 

 

 

 

 

15. Нарисуйте с помощью инструмента Свободная форма блик 

(Рис.7.11). 

 

 

 

 

16. 

Продублируйте блик и немного уменьшите, 

но, не просто уменьшая размеры, а слегка сжимая 

границы (Рис.7.12). 

17.  Залейте блик большего размера цветом C40 M0 Y0 K0, а блик поменьше – белым 

цветом. Контур уберите. 

18. Повторите шаги 12 – 14, применяя к получившемуся блику инструменты 

Интерактивное перетекание и Интерактивная прозрачность. Результат – на Рис.7.13. 

19. Нарисуйте блик с другой стороны капельки (можно копировать предыдущий и отразить 

Рис.7.10 Результат 
интерактивной 
прозрачности 

Рис.7.11 Создание 
блика 

Рис.7.12 
Уменьшенная копия 

блика 

Рис.7.13 Раскраска и 
прозрачность блика 

Рис.7.14 Копия и 
отражение блика 

Рис.7.15 Капелька ☺ 
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его по горизонтали, а затем уменьшить размеры). Результат – на Рис.7.14. 

20. С помощью инструмента Звезда добавьте капельке блеск (в примере количество узлов 

=7). Итоговый результат – на Рис.7.15. 

 

ПРАКТИЧЕСКАЯ РАБОТА №5 

ЧАСЫ 

Цель работы: научиться создавать изображение часов с помощью программы Corel Draw 

1. С помощь инструмента Эллипс нарисуйте круг (для того чтобы он действительно был 

круглым, удерживайте нажатой клавишу Ctrl). 

2. Нажмите Ctrl+Q, чтобы преобразовать эллипс в 

кривую. 

3. Щелкните на кнопку в правом нижнем углу экрана 

«Цвет абриса» (на рисунке – черным цветом) . 

4. В открывшемся окне установите ширину абриса как 

«сверхтонкий абрис», параметры цвета: C0 M0 Y0 K30 

5. Нажмите F11 для открытия окна радиальной 

заливки, примерные параметры которой показаны на 

Рис.12.1 (нижний серый цвет - C0 M0 Y0 K20). Результат – 

на Рис.12.2. 

6. Выберите инструмент Интерактивная тень и 

добавьте ее к эллипсу, примерно так, как на Рис.12.3. 

7. Скопируйте кривую-эллипс (Ctrl+C) и 

вставьте поверх исходной (Ctrl+V). Если кривая 

скопировалась с тенью, то удалите тень со 

вставленной кривой. 

8. Уберите у второй кривой (которую вставили) 

толщину обводки. 

9. С помощью инструмента Выбор, удерживая 

клавишу Shift, немного сожмите кривую, а затем 

поверните ее на 180° (Рис.12.4).  

Рис.12.1 Параметры заливки 

Рис.12.2 Результат 
заливки 

Рис.12.3 
Направление тени 

Рис.12.4 Сжатие и 
поворот кривой 

Рис.12.5 
Закраска 

второй кривой 
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10. Теперь скопируйте повернутую кривую и вставьте ее поверх скопированной (Ctrl+C, 

Ctrl+V). 

11. Установите сверхтонкую черную обводку, закрасьте белым цветом  

и снова немного сожмите, как в предыдущем шаге (Рис.12.5). 

12. Залейте центральный белый круг радиальной заливкой так, чтобы 

более светлый зеленый был в центре (цвет можно установить свой). Цвета: 

темно-зеленый – C93 M46 Y97 K30, светло-зеленый – C80 M15 Y82 K0 

(Рис.12.6).  

13. С помощью инструмента Эллипс нарисуйте еще два круга белого 

цвета и расставьте их так, как на Рис.12.7. 

14. Выделите оба круга и выберите Упорядочить → Сгруппировать (или 

Ctrl+G). 

15. Выделите группу инструментов Выбор и сместите у нее 

точку вращения (Рис.12.8). 

16. Скопируйте группу и вставьте ее поверх исходной (Ctrl+C, 

Ctrl+V). 

17. Удерживая клавишу Ctrl, поверните группу на 90° в любом 

направлении (Рис.12.9). 

18. Повторите шаги 16 и 17 еще два раза. Результат – на 

Рис.12.10. 

19. Выделите созданные группы циферблата и объедините их 

(Упорядочить → Сгруппировать, Ctrl+G). 

20. Скопируйте объединенную группу и, удерживая клавишу 

Ctrl, поверните ее примерно на 30°. 

21. Повторите шаг 20. Результат – на Рис.12.11. 

22. Откройте диспетчер объектов (Инструменты 

Диспетчер объектов). 

Рис.12.6 Закраска 
центральной части 

Рис.12.8 Выбор группы и 
смещение точки центра вращения 

Рис.12.9 
Копирование и 

поворот 
группы 

Рис.12.10 
Результат 3-

кратного 
копирования 

Рис.12.11 
Копирование 
объединенн

ой группы 
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23. Выделите в диспетчере объектов с помощью инструмента Выбор созданные группы 

(Рис.12.12) и выберите Упорядочить → Формирование → Объединить (или нажмите на 

панели инструментов кнопку «Объединить). 

Результат – на Рис.12.13. 

24. Выделите группу и в меню выберите 

Упорядочить → Преобразовать 

абрис в объект. 

25. Добавьте цифры с помощью 

инструмента Текст и нарисуйте с 

помощью инструмента Кривая 

стрелочки (Рис.12.14). 

26. С помощью инструмента 

Эллипс нарисуйте новый круг белого цвета, и с помощью 

инструмента Форма приведите его к виду, примерно как на Рис.12.15. 

27. Примените к фигуре Интерактивную прозрачность, примерно так, как на Рис.12.26. 

28. Аналогично, повторив шаги 27 и 27, 

сделайте прозрачную тень внизу часов 

(Рис.12.27, 12.28). 

29. Результат – на Рис.12.29 (к циферблату 

добавлена тень). 

 

 

 

Рис.12.12 Выделение 
группы объектов 

Рис.12.13 Объединение 
группы объектов 

Рис.12.14 
Добавление стрелок 

и цифр 

Рис.12.15 
Преобразование 

эллипса 

Рис.12.16 Наложение 
прозрачности 

Рис.12.27 Создание 
эллипса для тени внизу 

часов 

Рис.12.28 Наложение 
прозрачности на 

нижнюю тень 
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ПРАКТИЧЕСКАЯ РАБОТА №6 

ВЕСЕННИЕ ЦВЕТЫ 

Цель работы: научиться создавать изображение нарисованных цветов с помощью 

программы Corel Draw 

1. С помощью инструмента Прямоугольник 

нарисуйте прямоугольник. 

2. Примените к нему инструмент Интерактивное 

искажение (Рис.15.1). 

3. Скопируйте 3 раза полученную фигуру. 

Сдвиньте одну из них в сторону, она пока не понадобится. 

4. Выделите одну из двух оставшихся фигур и, 

нажав Shift, уменьшите ее размеры от угла 

(Рис.15.2). 

5. Уменьшенную фигуру залейте 

цветом C0, M7, Y17, K0, первоначальную 

C35 , M0, Y0, K0. 

6. Уберите контуры (Рис.15.3). 

Рис.12.29 Часы ☺ 

Рис.15.1 Применение инструмента 
Интерактивное искажение 

Рис.15.2 Уменьшение одной из фигур Рис.15.3 Заливка фигур 
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7. Примените к раскрашенным 

фигурам Интерактивное перетекание 

(Рис.15.4). 

8. Залейте отложенную фигуру 

белым цветом, контур C35, M0, Y0, K0 

и примените к ней инструмент 

Интерактивная прозрачность, 

радиального типа 

(Рис.15.5). 

9. Поместите эту фигуру на предыдущие. С помощью 

меню Упорядочить → Выровнять и распределить выровняйте фигуру по центру (Рис.15.6). 

10. Теперь нарисуйте круг с помощью инструмента Эллипс (нажав кнопку Ctrl).  

11. Примените к нему инструмент Интерактивное 

искажение (Рис.15.7). 

12. Полученное изображение 

копируйте, перемещая вокруг оси, пока не 

получится круг, как на Рис.15.8. Цвет контура 

и заливки по усмотрению. 

13. Сгруппируйте полученные круги, 

вставьте в центр первой группы и Ваш цветок почти готов (Рис.15.9). 

14. Чтобы придать более живой вид цветкам на лепестках с 

помощью инструмента Кривая через 3 точки нарисуйте фигуры, как на 

Рис.15.10. 

15. Залейте белым цветом (контур бесцветный) и примените 

инструмент Интерактивная прозрачность (Рис.15.11). 

16. Создайте еще несколько цветков, чтобы затем на ветке их было 

Рис.15.4 Применение 
инструмента Интерактивное 

перетекание 

Рис.15.5 Применение 
инструмента 

Интерактивная 
прозрачность 

Рис.15.6 Настройка 
выравнивания 

Рис.15.7 Применение 
инструмента Интерактивное 

искажение к эллипсу Рис15.8 Копирование искаженного 
круга и его поворот 

Рис.15.9 Цветок почти 
готов 

Рис.15.10 Создание фигур 
для придания объема 

лепесткам 

Рис.15.11 Применяем 
заливку и прозрачность 
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несколько. 

17. Нарисуйте ветку с использованием инструмента Свободная форма (Рис.15.12). Ветка 

состоит из трех частей. 

18. Скопируйте дважды каждую часть. 

19. К первоначальным фигурам ветки примените 

инструмент Интерактивный контур (цвет контура и заливки C0, 

M60, Y60, K40) (Рис.15.13). 

 

20. Копии залейте C0, M46, Y100, K11 

цветом, и примените к ним инструмент Интерактивная прозрачность (Рис.15.14). 

21. Вставьте на первоначальные фигуры и сгруппируйте. 

22. Для создания листочка нарисуйте овал и примените к нему 

инструмент Интерактивное искажение (Рис.15.15). Цвет заливки C68, M0, 

Y100, K24. 

23. Примените инструмент 

Интерактивный контур (цвет C40, M0, Y100, 

K0) (Рис.15.16). 

Рис.15.12 Создание частей ветки 

Рис.15.13 Заливка первоначальных фигур Рис.15.14 Заливка копий и применение прозрачности 

Рис.15.15 Создание листочка 

Рис.15.16 
Наложение 

прозрачности 
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24. Наложите листочек и цветы на ветку (Рис.15.17). 

25. Обведите с помощью Свободной формы контуры в тех частях ветки, которые 

выступают из-под цветков. Копируйте 

и уменьшите, нажав кнопку Shift 

(Рис.15.18). 

26. Уменьшенные фигуры 

залейте цветом C0, M10, Y26, K6 

цветом, первоначальные - цветом C0, 

M37, Y100, K23 (контуры бесцветны). 

27. На них примените 

интерактивное перетекание и 

вставьте на ветку (Рис.15.19). 

28. Сгруппируйте все объекты 

и примените к ним инструмент 

Интерактивная тень (Рис.15.20). 

29. Ветка готова (Рис.15.21). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ПРАКТИЧЕСКАЯ РАБОТА №7 

Рис.15.17 Наложение цветов 
на ветку 

Рис.15.18 Обводка выступающих 
частей 

Рис.15.19 Вставка обведенных 
и закрашенных частей на ветку Рис.15.20 Наложение тени 

Рис.15.21 Готовая ветка ☺ 
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БОКАЛ 

Цель работы: научиться создавать изображение бокала с помощью программы Corel 

Draw 

1. С помощью фигуры Эллипс нарисуйте овал и залейте его 

линейной заливкой (Рис.18.1). 

2. С помощью инструмента Прямоугольник нарисуйте 

прямоугольник (Рис.18.2). 

3. С помощью инструмента Форма сделайте из 

прямоугольника такую фигуру, как на Рис.18.3. 

4. Теперь выделите две фигуры и нажмите 

Пересечение . Результат – на Рис.18.4. 

5. Залейте получившуюся при пересечении фигуру 

Радиальной заливкой (Рис.18.5). 

6. Теперь нарисуйте прямоугольник (это будет фон) и 

залейте его каким-нибудь цветом, желательно потемнее, 

чтобы было лучше видно стекло. 

7. Нарисуйте еще один овал для бокала. Сделайте ему 

нулевую заливку, а контур 1мм, белый (Рис.18.6). 

8. Примените к этому овалу Интерактивную прозрачность с такими 

настройками (рис.18.7). 

Рис.18.1 Заливка овала 

Рис.18.2 Создание 
прямоугольника 

Рис.18.3 Изменение 
формы 

Рис.18.4 Результат 
пересечения 

Рис.18.5 Результат 
радиальной заливки 

Рис.18.6 Создание 
ободка 

Рис.18.7 Настройка прозрачности 
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9. Создаем блики. Нарисуйте несколько произвольных фигур, сделайте нулевой контур, а 

заливку белой (Рис.18.8). 

 

 

 

 

 

 

 

10. К 

этим фигурам 

примените 

Интерактивную прозрачность (Рис.18.9). 

11. Нарисуйте подставку (Рис.18.10). 

12. Теперь делаем блики на ножке. 

Опять нарисуйте формы для бликов и залейте 

их белым цветом (Рис.18.11). 

13. Применяем к бликам инструмент 

Интерактивная прозрачность (Рис.18.12). 

14. Бокал готов (Рис.18.13). 

 

 

Рис.18.8 
Создание 

бликов 

Рис.18.9 Наложение 
прозрачности Рис.18.10 Создание 

ножки 

Рис.18.11 Закраска 
бликов на ножке 

Рис.18.12 Наложение 
прозрачности 
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ПРАКТИЧЕСКАЯ РАБОТА №8 

ПОДСТАВКА ДЛЯ ЦВЕТОВ 

Цель работы: научиться создавать изображение подставки для цветов с помощью 

программы Corel Draw 

1. Выставляем вертикальную ось 

посреди листа - 105 мм. На высоте 100 мм 

рисуем эллипс 50х20 и удвоенную 

(подобную) его копию - 100х40 - на 

высоте 220 мм. Эти два эллипса 

соединяем по касательной наклонной 

осью (Рис.20.1). 

Рис.18.13 Готовые бокалы ☺ 

Рис.20.1 Создание основы Рис.20.2 Создание завитушек 
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2. На наклонной оси рисуем линию со спиральными завитушками на концах. Снизу 

завитушка больше, чем наверху (Рис.20.2). 

Описание подставки. Подставка состоит из 

• Двух соединительных колец. Это два наших эллипса. 

• Трех ножек. Одну мы нарисовали. 

• И двух стеклянных полочек. Одна кладется на верхнее кольцо. 

Другая где-то (как-то) посредине 

Поскольку ножек три, углы между ними должны быть 120 

градусов 

3. Поместите ножку в прямоугольную плоскость. Две 

горизонтали (верхняя и нижняя) - это касательные к верху и низу ножки. 

Левую вертикаль возьмите 35 мм (для ровного счета), а правая 

вертикаль образована точкой пересечения наклонной оси и нижней 

горизонтали. В примере получилась ось 86 мм. (Поскольку завитки у 

всех более или менее произвольные, этот размер будет у всех 

разный) (Рис.20.3).  

4. Ножку и эту вспомогательную плоскость сгруппируйте 

и в дальнейших построениях эту группу считайте «Ножкой-1». 

Теперь определим образующие, по которым будут идти 

две другие ножки. По сути дела, надо каждый эллипс (верхний и 

нижний) разбить на три части и по этим разбивкам провести 

оси. 

5. Перенесите эллипсы на другую страницу. 

6. Для нижнего эллипса постройте его окружность - 50 мм.  

7. Отложите оси ±60 градусов (в сумме 120). И из точек пересечения опустите 

перпендикуляры на эллипс (Рис.20.4). 

8. То же самое делаем для верхнего эллипса. Получаем на нем две точки и соединяем эти 

точки осями (Рис.20.5). По этим осям должны лечь (или прислониться к ним) две остальные 

ножки. 

Рис.20.3 Размещение 
ножки в плоскости 

Рис.20.4 Построение 
направляющих для нижнего 

эллипса 
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9. Для построения ножки, которая повернута к 

нам, построим еще подобные эллипсы снизу в углах 

вспомогательной плоскости и сверху по наружному 

углу. Большая диагональ малого эллипса: 105 - 86 = 

19 х 2 = 38. Для большого эллипса: 105 - 35 = 70 х 2 = 

140. Высоту их размещения тоже легко узнать. Надо 

провести горизонтальную ось и посмотреть ее 

значение на Панели свойств (в примере 71,101 - для 

нижних эллипсов и 228,62 - для верхнего). Также 

проведите еще нижнюю горизонтальную ось 

(радиус) ОА, на которой должна стоять 

вспомогательная плоскость второй ножки (Рис.20.6). 

10. Копируем «Ножку-1» и тут же ее 

вставляем, переименовываем в «Ножку-2», 

симметрично отражаем (относительно вертикальной 

оси).  

11. Пятку «Ножки-2» устанавливаем в точку 

«а». Координаты точки «а» легко определяются, 

если выставить в ней горизонтальную и вертикальную 

оси (в примере это 114,49 по горизонтали и 64,516 по 

вертикали). В «Докере преобразований» (на вкладке 

«Положение») надо поставить галочку в левый 

нижний угол и выставить координаты (Рис.20.7). 

12. «Пятка» «Ножки-2» встает в нужное место 

(Рис.20.8). 

Рис.20.5 Построение 
направляющих для 
верхнего эллипса 

Рис.20.6 
Построение 

дополнительных 
эллипсов для ножки 

Рис.20.7 Установка 
координат 

Рис.20.8 «Ножка-2» 
встала на место 

Рис.20.9 Установка 
«Ножки-2» Рис.20.10 Установка 

«Ножки-2» в точку «а» 
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13. Выделяем «Ножку-2», инструментом «Пик» приводим ее в состояние вращения (центр 

вращения устанавливаем в точку «а») и поворачиваем ее так, чтобы рисунок ножки лег на 

наклонную ось (Рис.20.9).  

14. Инструментом «Пик» сплющиваем (или) раздвигаем, сужаем (или 

расширяем), скашиваем «Ножку-2» так, чтобы, в конце концов, «пятка» 

плоскости была в точке «а», низ плоскости шел по радиусу, нижний угол был 

на пересечении нижнего эллипса и радиуса, а верхний угол на верхнем эллипсе 

(рис.20.10).  

15. Для «Ножки-3» построения аналогичные (Рис.20.11).  

16. Теперь вспомогательные плоскости и эллипсы не 

нужны, их можно удалить (Рис.20.12). 

17. Установите толщину ножек: «Ножка-2» к нам ближе всего - будет 

самой толстой (толщина - 3). «Ножка-3» самая тонкая (толщина - 2), а «Ножка-

1» - средняя (толщина - 2,5). 

18. Сразу же с установкой толщин в докере «Перо абриса» установите 

округлые концы линий. 

19. Переведите все «Ножки» и соединительные кольца в объекты, 

покрасьте и сделайте блики (Рис.20.13).  

20. Итоговый вид подставки с полочками показан на Рис.20.14. 

Рис.20.11 
Построение 
«Ножки-3» 

Рис.20.12 Убираем 
вспомогательные 

плоскости и эллипсы 

Рис.20.13 Закраска ножек 
и наложение бликов 
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ПРАКТИЧЕСКАЯ РАБОТА №9 

Освоение приемов художественной обработки фотографий в программе Adobe 

Photoshop. 

Цель работы: знакомство с основными характеристиками цифровых фильтров, 

поддерживаемых программой Adobe Photoshop, и принципами художественной обработки 

изображений на их основе; получения практических навыков по применению цифровых фильтров 

как к изображению в целом, так и к отдельным его частям. 

Исходные изображения: 

  
1. Работа со слоями, масками, наложение градиента. 

Рис.20.14 Готовая подставка для 
цветов ☺ 
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Layers(Слои) → Add layer mask>Reveal All (Добавить слой маску) → Gradient (Градиент) 

→ Radial Gradient → Opacity (Прозрачность) 

2. Применение фильтра Radial Blur (Радиальное размытие к части изображения). 

 
Layer 2>Dublicate Layer (Слой>Дублировать) → Elliptical Marquee (Эллиптическое 

выделение) → Select>Inverse (Выделение>Инверсия → Filter>Blur>Radial Blur 

(Фильтр>Размытие> Радиальное размытие) 

3. Применение фильтра «Блик» 
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Filter>Render>Lens Flare (Фильтр>Визуализация>Блик). 

 

ПРАКТИЧЕСКАЯ РАБОТА №10 

Эффект размытого фона 

Цель работы: 

1. Откройте фотографию с дельфинами, продублируйте изображение.  
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2. Любым способом выделите дельфинов.  

3. Инвертируйте выделение командой Выделение – Инверсия.  

4. Для копии изображения выполните команду Фильтр – Размытие – Размытие при малой 

глубине резкости, радиус – 20.  

5. Выполните сведение слоев. 

 

 

ПРАКТИЧЕСКАЯ РАБОТА №11 

Эффект дождя 

Цель работы: Научиться использовать эффекты имитации дождя с помощью фильтров 

1. Откройте любую фотографию и продублируйте изображение.  

2. Создайте новый пустой слой. Залейте его черным цветом.  

3. Примените Фильтр - Шум – Добавить шум с параметрами: Эффект = 35, распределение по 

Гауссу, Монохромный  

4. Примените еще один Фильтр – Размытие – Размытие в движении угол = -84, смещение =30.  

5. На панели «Слои» изменим режим наложения слоя «Дождь» на Экран. 
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ПРАКТИЧЕСКАЯ РАБОТА №12  

Лед 

Цель работы: Создать текст с эффектом льда, используя фильтры 

1.   Создаем новую заготовку 300*200, разрешением 150, черно-белую с белым фоном. 

2.   Используя черный цвет, пишем “ice” шрифтом Times New Roman, Bold Italic 25 пунктов по 

центру. 

3.   Растрируем текстовый слой. 

4.   Фильтр / Шум / Добавить шум, 70%, одноцветный. 

5.   Сводим слои. 

6.   Фильтр / Оформление / Кристаллизация, размер ячейки = 3 

7.   Изображение / Повернуть холст / 90 против часовой 

8.   Изображение / Коррекция / Инверсия 

9.   Для создания сосулек: Фильтр / Стилизация / Ветер, Способ - Ветер, Направление - слева. 

10. Разворачиваем холст обратно 

11. Изображение / Режим/ RGB. 
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12. Изображение / Коррекция / Цветовой тон/Насыщенность. Включить тонирование (190, 70, 

+3). 

 

 

ПРАКТИЧЕСКАЯ РАБОТА №13 

Пламя 

Цель работы: Создать текст с эффектом пламени используя фильтры 

1.   Создаем новую заготовку (например, 300*100, разрешением 150, Черно-белое с белым 

фоном). 

2.   Пишем DESIGNER горизонтальным текстом. 

3.   Фильтр / Размытие / Размытие Гаусса 1 пкс. 

4.   Изображение / Повернуть холст / 90 против часовой. 

5.   Свести слои. 

6.   Проинвертировать цвета: Изображение / Коррекция / Инвертировать. 

1.   Для создания языков пламени: Фильтр / Стилизация / Ветер, Способ - Ветер, Направление - 

слева. 

7.   Для большей реалистичности используем Фильтр / Искажение / Рябь 50, размер-средний). 

8.   Разворачиваем холст обратно. 

9.   Изображение / Режим / Индексированные цвета. 

10. Изображение / Режим/ Таблица цветов / Абсолютно черное тело 
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ПРАКТИЧЕСКАЯ РАБОТА №14 

Сияющий текст 

Цель работы: Создать текст с эффектом сияния используя фильтры 

1.   Создаем новую заготовку (например, 300*300, разрешением 150, RGB). 

2.   Заливаем фон черным цветом. 

3.   Используя белый цвет, пишем «сияющий текст» шрифтом Arial Black, 20 пунктов по 

центру. 

4.   Объединяем слои. 

5.   Фильтр / Размытие / Размытие Гаусса 2 пкс. 

6.   Фильтр / Стилизация / Соляризация. 

7.   Создаем копию текущего слоя 

8.   Применяем к копии: Фильтр / Искажение / Полярные координаты с параметром Полярные к 

прямоугольному 

9.   Инвертируем изображение. 

10. Поворачиваем на 90 градусов по часовой стрелке. 

11. Три раза выполняем Фильтр / Стилизация / Ветер с параметрами Способ - Ветер, 

Направление - Справа. 

12. Изображение / Коррекция / Автоуровни. 

13. Инвертируем изображение. 

14. Три раза выполняем Фильтр / Стилизация / Ветер с прежними параметрами. 

15. Поворачиваем на 90 градусов против часовой стрелки. 

16. Фильтр / Искажение / Полярные координаты с параметром Прямоугольные в полярные. 

17. Нижний слой перетаскиваем наверх. 

18. Задаем режим смешивания «экран». 

19. Объединяем слои. 
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ПРАКТИЧЕСКАЯ РАБОТА №15 

Подсветка 

Цель работы: Добавить эффект сияния на фотографию 

1. Откройте изображение 

 
2. Продублируйте слой. К дубликату примените Изображение > Коррекция > Порог, Уровень 

порога 100 

 
3. Фильтр > Размытие >Радиальное размытие. Зачение 100, Метод Линейный, Качество 

наилучшее. Перенесите центр размытия в начало подсветки  
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4. Установите режим наложения слоя Осветление, прозрачность 60%. 

Большим мягким ластиком скорректируйте верхний слой 

 
 

ПРАКТИЧЕСКАЯ РАБОТА №16 

Каменная стена 

Цель работы: с помощью фильтров сделать имитацию каменной стены 

1. Новый документ 1000x1000, Grayscale. Заливаем серым.  

2. Filter > Noise > Add Noise (70%, Gaussian, Monochromatic)  

3. Filter > Blur > Gaussian Blur (Radius 1)  

4. Filter > Pixelate > Crystallize (Cell Size 100)  

5. Копируем задний слой, к копии применяем Filter > Stylize > Find Edges  

6. Image > Adjustment > Levels (Ctrl+L) – все рукоятки вправо до отказа  

7. Выделяем с помощью Magic Wand белый цвет, уменьшаем выделение на 5 (Select > Modify 

> Contract), растушевываем на 5 (Select > Feather)  

8. Удаляем копию слоя  

9. Вырезаем выделенную область на новый слой  

10. Задний слой заливаем черным  

11. К новому слою применяем Layer > Layer Style, как показано ниже 
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12. Сводим слои. По желанию повышаем резкость: Filter > Sharpen > Unsharp Mask 

 

 

 

 

 

 

 

 

 

 

ПРАКТИЧЕСКАЯ РАБОТА №17 

Цель работы: 

- ознакомиться с системой AUTOCAD;  

- научиться вычерчивать геометрические контуры при помощи простейших графических 

примитивов; 

- освоить работу со слоями в системе AUTOCAD; 

- научиться создавать надписи на чертежах. 

 

Содержание работы:  

1 Изучение основ работы в AUTOCAD; 

2 Вычерчивание геометрических контуров при помощи простейших графических примитивов: 

Line (формирование отрезка), Polygon (Построение многоугольника),  Rectangle 

(Формирование прямоугольника), Сircle ( формирование окружности), Hatch – (Формирование 

штриховки) 

3 Работа со слоями 

4 Создание надписей на чертеже 
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1. ЗАПУСК СИСТЕМЫ AUTOCAD 

Запуск AutoCAD осуществляется следующими способами: 

- в строке задач щелкните по кнопке Start (Пуск), выберите пункт Programs (Программы) и 

затем осуществите запуск из выпавшего меню при помощи команды AutoCad  

- на рабочем столе Windows щелкните дважды на пиктограмме AutoCAD  

Во время запуска AutoCAD создается новый неименованный рисунок. Пользователь 

может либо начать создавать объекты в нем, либо загрузить с диска один из уже имеющихся 

рисунков. 

Общий вид рабочего окна AutoCAD представлен на рисунке 1. 

 
 

 Рисунок 1 - Общий вид рабочего окна AUTOCAD 

Верхняя строка рабочего окна – СТРОКА ПАДАЮЩИХ МЕНЮ – включает в себя ряд 

меню, позволяющих: 

- осуществлять операции с файлами рисунков - меню File (Файл); 

- выполнять оперативное редактирование чертежа- меню Edit (Редактировать); 

- управлять экраном, установкой панелей инструментов- меню View (Вид) 

- вставлять блоки, внешние объекты - меню Insert (Вставка) 

- настраивать параметры линий чертежа, размерных стилей, текстовых стилей, 

осуществлять выбор единиц измерения- меню Format (Формат) 

- управлять системой в целом (настройка экрана, установка параметров черчения и т.п.) – меню 

Tools (Сервис) 

- выполнять построения различных графических элементов меню Draw  (Рисование) 

Р
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- проставлять размеры на чертеже - меню Dimension (Размеры) 

- редактировать изображения – меню Modify (Редактировать) 

- организовывать многооконный режим работы с чертежами - меню Window (Окна) 

- вызывать систему гипертекстовых покдсказок - меню Help (Помощь) 

СТАНДАРТНАЯ ПАНЕЛЬ ИНСТРУМЕНТОВ содержит наиболее часто 

используемые команды меню: создание нового рисунка, сохранение чертежа, печать, работа с 

буфером обмена и т.д. 

ПАНЕЛЬ СВОЙСТВ ОБЪЕКТА предназначена для работы со слоями. 

ОКНО КОМАНДНЫХ СТРОК – область, где отображаются вводимые пользователем 

системы команды. 

В СТРОКЕ СОСТОЯНИЯ расположен счетчик координат и прямоугольные кнопки 

различных режимов черчения. 

Управление системой AUTOCAD заключается: 

- в выборе команды для исполнения; после выбора команды в окне командных строк возникает 

соответствующий запрос; 

-  корректном ответе на запрос системы; 

- выбора следующей команды и т. д.  

 

2 .СОЗДАНИЕ ЧЕРТЕЖЕЙ осуществляется в пространстве модели. В этом режиме 

должна быть активной вкладка Model (Модель) строки состояния (рис. 1). При построении 

объектов используется масштаб 1:1. 

Любой чертеж состоит из простейших графических объектов: отрезков, дуг, окружностей и т.д. 

В системе AUTOCAD они называются примитивами.  Операции построения примитивов могут 

быть выполнены при помощи панели инструментов Draw (рисование). Вызвать команду для 

построения простого графического объекта, например, отрезка можно следующим образом: 

1. Ввести на клавиатуре Line (в английской версии) или ОТРЕЗОК в русскоязычной версии, 

затем нажать клавишу ENTER 

2. Из падающего меню Draw (рисование)- Line (Отрезок) 

3. Щелчком мышки по пиктограмме    Line – формирование отрезка – наиболее 

предпочтительный способ. 

После выбора инструмента в командной строке появляется запрос: Specify first point:   

(укажите начало отрезка). В ответ на этот запрос необходимо задать положение первой точки 

отрезка. 

Существует три основных способа ввода координат точки: 

- указание координат точки непосредственно щелчком мыши на экране; 

- ввод координат точки в командной строке в абсолютной системе координат, например, 

160,234. Здесь X=160, Y=234 – в текущей системе координат; 

- ввод координат точки в командной строке в относительной системе координат. Для этого 

необходимо, используя режим объектной привязки, установить курсор в точку относительно 

которой необходимо выполнить построения и ввести в командной строке величины смещений 

по X, Y, например, @-26,134. 

В ответ на второй запрос Specify next point or [Сlose/Undo] (Введите следующую точку 

или [Отменить/Замкнуть]): следует одним из вышеперечисленных способов задать положение 

второй точки отрезка. 
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Наиболее простой способ построения отрезка заданной длины: Задать положение 

первой точки отрезка щелчком мыши, выбрать направления смещения для построения второй 

точки и с клавиатуры ввести длину отрезка, нажать клавишу ENTER. 

Слова, указанные в квадратных скобках [Сlose/Undo] называют ключами. Если в 

процессе работы необходимо, например, отменить предыдущее построение следует в 

командную строку ввести первую букву ключа «U», или щелчком правой кнопки мыши вызвать 

контекстное меню и из него выбрать имя ключа Undо (отмена). 

Большинство команд панели инструментов Draw (рисование) – циклические, например, 

выбрав режим рисования прямых, их можно рисовать бесконечно. Прекратить действие 

циклической команды можно либо нажав <Esc>, либо выбрав одну из команд (Enter или Cancel) 

в контекстном меню. 

Основные команды панели инструментов Draw (рисование), необходимые для 

выполнения лабораторной работы приведены в табл. 1 Приложения А. 

 

В процессе работы целесообразно включать следующие режимы (См. рис.1, строка 

состояния): 

  ORTHO - включение / выключение ортогонального режима при вычерчивании взаимно 

перпендикулярных линий чертежа 

 POLAR - включение / выключение полярного режима – режим, являющийся 

расширением режима  ORTHO, позволяет отлеживать углы с некоторым настраиваемым 

шагом. Включение режима POLAR автоматически выключает режим ORTHO. 

 Режим POLAR является наиболее предпочтительным при выполнении данной 

работы. 

 OSNAP - включение / выключение режимов объектной привязки.  Режим OSNAP 

необходим для точного указания положения точки на объекте.  

  Например, если необходимо провести линию от середины отрезка, следует после выбора 

инструмента Line, подвести курсор к отрезку, AutoCAD обнаружит середину вычерченного 

отрезка, о чем просигнализирует значком в виде треугольника посередине отрезка, затем в 

ответ на запрос компьютера Specify first point (Введите первую точку) щелкнуть левой кнопкой 

мышки по значку треугольника и продолжить построение отрезка. 

 OTRACK - включение / выключение режима отслеживания.  

 Удаление линий можно осуществить следующим образом: 

- щелнуть по линии левой кнопкой мышки, затем нажать клавишу DELETE 

- щелнуть левой кнопкой мышки вверху слева над удаляемым изображением и снизу справа, 

затем нажать клавишу DELETE 

3.РАБОТА СО СЛОЯМИ 

Распределение по слоям позволяет использовать чертеж AutoCAD для различных целей. На 

одном и том же рисунке можно представить на одном слое готовый чертеж детали, на другом – 

линии проекционной связи. 

При выполнении данной работы рекомендуется создать несколько слоев, соответствующих 

определенным типам линий на чертеже: 

Сплошная основная, толщина S = 0,6…0,8 мм 

Сплошная тонкая, толщина линии S/3… S/2 

 Штрихпунктирная линия, толщина S/3… S/2 

Штриховая, толщина S/3… S/2 
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Работа со слоями производится в диалоговом окне Layer Properties Manager, 

вызываемого из меню Format – Layers  (рисунок 2): 

 

 
 

 Рисунок 2 – Панель работы со слоями. 
Для создания нового слоя нужно нажать левую клавишу «мыши» на кнопке New, 

расположенной в верхнем правом углу диалогового окна. Новый слой с именем Layer 1 (Слой 1) 

появится в списке слоев. Его имя можно сразу изменить на более подходящее.  

Для задания дополнительных параметров слоя необходимо выбрать кнопку Show Details. 

Появятся дополнительные параметры слоя, такие как цвет, толщина, тип линий, стиль печати. 

Для изменения, например, цвета необходимо щелкнуть на кнопке со стрелкой вниз для 

отображения списка Color. Раскроется список, показывающий доступные для выбора цвета, 

которые можно назначить данному слою. Для закрытия подменю дополнительных параметров 

слоя необходимо произвести второе нажатие на данную кнопку, которая к этому времени сменит 

название на Hide Details. 

В процессе создания чертежа иногда желательно отключать или же наоборот включать 

видимость того или иного слоя. Для этого необходимо в диалоговом окне Layer Properties 

Manager выбрать нужный слой из списка. Затем щелкнуть на значке «Электрическая лампочка», 

расположенном сразу за именем слоя в списке, расположенном сразу за именем слоя. Желтый 

цвет данного значка говорит о том, что слой включен, си-ний – выключен. 

При вычерчивании чертежа все линии в пространстве модели имеют одинаковую 

толщину, для отображения толщины линий (веса) следует выбрать кнопку LWT строки 

состояния. В процессе работу этот режим желательно отключать. 

ЗАДАНИЕ 

 Выполнить построения геометрических объектов согласно варианту. Внести 

необходимые надписи в чертеж. Образец выполнения листа приведен на рисунке 8. 

 Вариант  задания соответствует порядковому номеру ПК. 

 

ПОРЯДОК ВЫПОЛНЕНИЯ 

1. Ознакомиться с элементами интерфейса системы автоматизированного проектирования 

AutoCAD (п.1) 

2. Изучить основные принципы работы в среде AutoCAD 

3. Научиться вычерчивать геометрические объекты при помощи следующих графических 

примитивов Line (Формирование отрезка), Polygon (Построение многоугольника), Rectangle 

(Формирование прямоугольника), Сircle (формирование окружности), Hatch – (Формирование 

штриховки) (см. п.2) Text – формирование динамического (однострочного и многострочного 

текста). 
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4. Освоить работу со слоями (см. п. 3). Создать необходимое для работы количество слоев 

(типов линий). Вычертить 4 типа линий чертежа: сплошную основную, сплошную тонкую, 

штриховую, штрихпунктирную (рис.3). Параметры линий выбрать в соответствии с 

требованиями ГОСТ 2.303-68 «Линии чертежа» 

 

 
   Рисунок 3 

 

 

5. Вычертить прямоугольник с размерами сторон А, В, мм. Размеры сторон выбрать: 

Для вариантов 1,3,5,7  А=90мм, В=70мм; (рис.4) 

   2,4,6,8:  А=100 мм, В=60мм; 

   10,12,14:  А=105мм, В=50мм; 

   9,11,13,15:  А=110мм, В=55 мм 

 

 
 

Рисунок 4 

 

6. Вычертить многоугольник с количеством сторон N, вписанный в окружность диаметром 

D (рис.5): 

Для вариантов 1,3,5,7          N = 5; D=60 мм 

   2,4,6,8:   N = 3; D=65 мм  

               10,12,14:   N = 7; D=70 мм 

   9,11,13,15:   N = 6;  D=80 мм 
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Рисунок 5 

 

7. Вычертить две окружности, заштриховать внутренний контур (рис. 6) 

 

         
Рисунок 6 

 

8. Вычертить контур детали (рис.7). Размеры с буквенными обозначения вычертить согласно 

варианту задания: 

Для вариантов: 1,3,5,7 N = 10мм; М= 25 мм;  R1=  15 мм;   R2= 35мм 

2,4,6,8:  N = 15мм; М = 30 мм;  R1=  20 мм;   R2= 35мм  

10,12,14:  N = 10мм; М = 40 мм;  R1=  25 мм;   R2= 40мм 

9,11,13,15:   N = 15мм;  М=45 мм;  R1=  20 мм;   R2= 40 мм 

 
 

Рисунок 7 
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1. Назначение системы автоматизированного проектирования AutoCAD, ее возможности. 

2. Краткая характеристика элементов интерфейса AutoCAD. 

3. Способы ввода команд AutoCAD. 

4. Что понимают под пространством модели? 

5. Назначение пространства листа. 

6. Перечислить способы задания координат точек в среде AutoCAD. 

7. Что понимают под объектной привязкой? Функции объектных привязок. Использование объектных 

привязок в работе. 

8. Перечислить основные режимы рисования, пояснить назначение каждого из режимов. Настройка 

режимов рисования. 

9. Что понимают в AutoCAD под слоем? Свойства слоя. Управление свойствами слоя. Объяснить 

команды меню Draw – Рисование: Line – формирование отрезка, Polygon –построение   

многоугольника,  Rectangle – формирование прямоугольника, Сircle – формирование окружности, 

Hatch – (Формирование штриховки); Text – формирование динамического (однострочного и 

многострочного текста). 

 

Для самостоятельного изучения: 
 Изучить команды меню Draw – Рисование: Ray – формирование луча;Соnstruction Line – 

формирование прямой;Arc – формирование дуги;  Multiline – формирование мультилинии; 

Polyline – формирование полилинии; Spline – формирование сплайна;Donut формирование 

кольца; Ellipse – формирование эллипса.  
 

ПРИЛОЖЕНИЕ А 

Таблица 1 Некоторые примитивы панели инструментов Draw (рисование)  

Наименование 

команды 

Пиктограмма 

 

Запросы 

  Line  

Формирование отрезка 

 

Specify first point: - укажите  начало отрезка; 

Specify next point or [ Close/Undo] укажите следующую точку или [замкнуть/отменить 

] 

   Polyline 

формирование 

полилинии 

 

Полилиния – это 

последовательность 

линейных и дуговых 

объектов, связанных 

между собой. 

Specify stаrt point: - указать первую точку; 

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: -указать вторую точку. 

Ключи: Arc – переход в режим дуг; 

Close – замкнуть полилинию отрезком; 

Halfwidth – задать полуширину, т.е. расстояние от осевой линии широкого сегмента до 

края; 

Length – задать длину сегмента, созданного как продолжение предыдущего в том же 

направлении; 

Undo – отменяет последний созданный сегмент; 

Width – позволяет задать ширину следующего сегмента 

 

   Polygon – 

формирование 

правильного 

многоугольника. 

Enter number of sides <default>: - указать кол-во сторон; 

Specify center of polygon or [Edge]: - указать центр многоугольника или [Задать 

многоугольник по одной стороне]: 

Enter an option [Inscribed in circle/Circumscribed about circle] <I>: - указать 

многоугольник вписанный (I) в окружность или описанный (C); 

Specify radius of circle: - указать радиус окружности. 
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   Rectangle – 

формирование 

прямоугольника 

 

Specify first corner point or [Chamfer/Elevation/Fillet/ Thickness/Width]: - задать первый 

угол; 

Specify other corner point – задать второй угол. 

Ключи: Chamfer – задать фаску; Elevation – задать уровень; Fillet – задать сопряжение; 

Thickness – задать высоту прямоугольника; Width – задать ширину прямоугольника 

 

 

 

   Сircle – 

формирование 

окружности 

 

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: - указать центр окружности; 

Specify radius of circle or [Diameter]: - указать радиус окружности или [диаметр]. 

Ключи: 3P –окружность по трем точкам, лежащим на ней; 

2P – окружность по двум точкам на диаметре; 

Ttr – окружность по двум касательным и радиусу; 

Tan Tan Radius –окружность по двум касательным и радиусу; 

Tan Tan Tan – окружность по трем касательным. 

 Spline – 

формирование 

сплайна 

Specify first point or [Object]: - указать первую точку; 

Specify next point:- указать следующую точку; 

Specify next point or [Close/Fit tolerance] <start tangent>: - указать следующую точку. 

Specify start tangent: (Направление касательной в начальной точке сплайна).  

Ключи:    Object – конвертация выбранных объектов в сплайн; 

Close – замкнуть сплайн; Fit tolerance – изменение величины допуска сплайновой 

аппроксимации. 

 

   Hatch – 

формирование 

штриховки 

Область штриховки может задаваться указанием линий, образующих границу 

Select Objects, или указанием внутренней точки области Pick Points. При этом границы 

области определяются автоматически.  

 

   
Text – формирование 

динамического 

(однострочного и 

многострочного 

текста). 

 

При выборе команды открывается дополнительное меню. 

Команды дополнительного меню: 

Multiline Text… -  ввод многострочного текста; 

Запросы: Specify first corner: - указать первый угол текстовой зоны; 

Запросы: Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: - 

указать противоположный угол текстовой зоны или 

[Высота/Выравнивание/Межстрочное расстояние/Угол поворота/Стиль/Ширина зоны]: 
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11.Формы текущего и итогового контроля 
 

✓ Практические задания к модулям. 

Вариант 1. Изучить параметры огибающих и эффекты деформации в программе CorelDRAW. 

Приобрести практические навыки по управлению эффектами огибающих и деформации. 

Вариант 2. Редактор растровой графики Adobe Photoshop: инструменты выделения и рисования, 

фильтры, трюки и спецэффекты 

 

Задачи: 

Создавать собственные иллюстрации, используя главные инструменты векторной программы 

CorelDRAW. 

Задание для самостоятельной работы: 

Примеры выполнения работы: 

 

    1)                         
 

2)                 
 

3)                        
 

4)                            
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5)                             

6)                              
 

7)                
 

8)                     
 

9)                  

10)           
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12.Учебно-методическая литература по дисциплине разработанная 
преподавателями отделения  
 

№ Библиографическое описание издания (автор, наименование, вид, место 

и год издания, кол. стр.) 

1 • Н.С. Сейтказиева, А.Т. Ибраева, Т.К. Ниязбеков, Компьютерная графика, Учебное 

пособие с практическими заданиями по компьютерной графике, Бишкек 2022г. -

108стр. 

2 • Н.С. Сейтказиева, Г.А. Токтогулова, Создание эффектов анимации в 3D Studio 

MAX, Методические указания, Бишкек-2010, 24 стр. 

3 • Н.С. Сейтказиева, Г.А. Токтогулова, Практикум по трехмерной графике, Учебно-

методическое пособие, Бишкек-2023, 131 стр. 

4 • Сейтказиева Н.С., Компьютерная графика, Учебно-дидактическое пособие с 

практическими заданиями по компьютерной графике для студентов Колледжа 

специальности «Программное обеспечение вычислительной техники и 

автоматизации систем», Бишкек-2017, 121 стр. 

5 • Н.С. Сейтказиева, А.Т. Ибраева, Т.К. Ниязбеков, Информатика, Учебное пособие, 

Бишкек 2022г. -152стр. 

6 • Н.С. Сейтказиева, А.Т. Ибраева, Т.К. Ниязбеков, Учебное пособие по выполнению 

практических заданий по дисциплине «Информатика», Бишкек 2022г. -104стр. 

7 • Н.С. Сейтказиева, С.А. Ниязмаметова, Г.А. Токтогулова, Практикум по дисциплине 

«Программное обеспечение», Учебное пособие, Бишкек-2022, 72 стр. 

 

Интернет-ресурсы 

• Ниязмаметова С.А., онлайн курс 

https://classroom.google.com/c/NjEyNzk1ODg4NTFa?cjc=ial3xyj 

• https://learningapps.org/myapps.php Ниязмаметова С.А., онлайн сервис с созданными 

мною заданиями. 
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13.Глоссарий. 
 

Компьютерная графика 

Машинная графика 

Computer graphics 

Компьютерная графика - технология создания и обработки графических изображений 

средствами вычислительной техники. 

Компьютерная графика изучает методы получения изображений, полученных на основании 

невизуальных данных или данных, созданных непосредственно пользователем. 

 

Векторная графика 

Vector graphics 

Векторная графика - метод графического представления объекта в виде отрезков прямых 

(векторов). 

В полиграфии векторная графика обычно используется для подготовки макетов. 

 

Графика 

Graphic art 

греч.Graphike; фр.Art graphique; нем.Graphik 

От лат.Grapho - рисую 

Графика - искусство изображения предметов контурными линиями и штрихами. Иногда в 

графике допускается применение цветных пятен. 

К графике относятся рисунок и различные виды его печатных воспроизведений: гравюра, 

литография, монотипия и др. 

В зависимости от содержания и назначения графика подразделяется:  

- на станковую;  

- на подготовительную: эскиз, набросок, зарисовки;  

- книжную и журнально-газетную;  

- прикладную графику: промышленную графику, грамоты, марки, этикетки, реклама и т.д.;  

- плакат. 

 

Графический примитив 

Graphic primitive 

Графический примитив - простейший геометрический объект, отображаемый на экране дисплея 

или на рабочем поле графопостроителя: точка, отрезок прямой, дуга окружности или эллипса, 

прямоугольник и т.п. 

 

Деловая графика 

Graphics for managers 

Деловая графика - технология создания изображений с сопровождающим текстом для нужд 

коммерции. 

 

 

Обработка изображений 

Image processing 

http://www.glossary.ru/cgi-bin/gl_sch2.cgi?RClqyuwtg9!jwg(oqg
http://www.glossary.ru/cgi-bin/gl_sch2.cgi?ROhwghuyqg!onuhwgmltop
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Обработка изображений - область компьютерной графики, исследующая задачи, в которых и 

входные и выходные данные являются изображениями. 

 

Растровая графика 

Растровая графика - метод графического представления объекта в виде множества точек. 

 

Система деловой графики 

Система деловой графики - система, позволяющая выводить на экран различные виды графиков 

и диаграмм: гистограммы, круговые и секторные диаграммы и т.д. 

 

Система научной и инженерной графики 

Система научной и инженерной графики - система, позволяющая в цвете и в заданном масштабе 

отображать на экране графики двумерных и трехмерных функций, заданных в табличном или 

аналитическом виде, системы изолиний, в том числе и нанесенные на поверхность объекта, 

сечения, проекции, карты и др. 

 

Трехмерная графика 

3D-графика 

Трехмерная графика - технология мультимедиа; компьтерная графика, создаваемая с помощью 

изображений, имеющих длину, ширину и глубину. 

 

Фрактал 

Fractal 

От лат.Fractus - состоящий из фрагментов 

Фрактал - объект, имеющий разветвленную структуру. Части фрактала подобны всему объекту. 

Фракталы используются в компьютерной графике для создания линий побережья, деревьев, 

облаков и других графических объектов. 

 

Глубина цвета 

термин компьютерной графики, означающий объём памяти в количестве бит, используемых для 

хранения и представления цвета при кодировании одного пикселя растровой графики или 

видеоизображения. Часто выражается единицей бит на пиксель (bpp). 

 

Графический редактор 

программное средство для создания и обработки изображений. 

 

Контраст 

разность максимального и минимального значений яркости, а также способность 

фотографического материала или оптической системы воспроизводить эту разницу. 

Пиксель 

комбинированный термин, обозначающий элемент изображения, являющийся наименьшим 

элементом экрана монитора. Другое название - pel. Изображение на экране состоят из сотен 

тысяч пикселей, объединенных для формирования изображения. Пиксель является 

минимальным сегментом растровой строки, которая дискретно управляется системой, 

http://www.glossary.ru/cgi-bin/gl_sch2.cgi?RQgxywuig9!jwg(oqg
http://www.glossary.ru/cgi-bin/gl_sch2.cgi?RSwl)slwtg9!jwg(oqg
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образующей изображение. С другой стороны, это координата, используемая для определения 

горизонтальной пространственной позиции пикселя в пределах изображения. Пиксели на 

мониторе — это светящиеся точки яркого фосфора, являющиеся минимальным элементом 

цифрового изображения. Размер пикселя не может быть меньше точки, которую монитор может 

образовать. На цветном мониторе точки состоят из групп триад. Триады формируются тремя 

различными фосфорами: красным, зеленым и синим. Фосфоры располагаются вдоль сторон друг 

друга. Пиксели могут отличаться размерами и формой, в зависимости от монитора и 

графического режима. Количество точек на экране определяются физическим соотношением 

ширины к высоте трубки. 

 

Разрешение 

величина, определяющая количество точек (элементов растрового изображения) на единицу 

площади (или единицу длины). Как правило, разрешение в разных направлениях одинаково, что 

даёт пиксель квадратной формы. Но это не обязательно — например, горизонтальное разрешение 

может отличаться от вертикального, при этом элемент изображения (пиксель) будет не 

квадратным, а прямоугольным. 

Цветовое освещение  

- освещение источниками разного цвета, при этом происходит смешение цвета. Совсем недавно 

цветовое освещение стало использоваться в новейших 3D играх (Quake2, Unreal, Prey, Half Life). 

 

Шрифт (font) 

набор знаков символов для представления текста в полиграфии, компьютерных системах, 

причем для этих знаков характерны единство стиля, размеров, одинаковость способов 

отображения. 

 

Яркость (или световая яркость) цифрового изображения 

величина уровней интенсивности в пиксельной матрице изображения, снятого цифровой 

камерой, или оцифрованного аналогово-цифровым преобразователем. Яркость – это величина 

уровней интенсивности всех пикселей вместе, составляющих цифровое изображение, которое 

было снято, оцифровано и отображено на экране. Яркость пикселей является очень важным 

элементом цифровых изображений, так как это единственная величина, которая используется 

техническими средствами обработки изображений. 
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